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Getting Started with Accelerando
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Minimum Requirements
Accelerando may be run on any Apple Computer running OS X 10.4.0 (Tiger) or
greater*.
All of Accelerando’s tools are built as Universal Binaries. This means they will run
natively under both Intel and PowerPC architectures.
Accelerando supports applications from several Developers. Naturally, you will need
these applications if you wish to script them. Links to these Developers can be
found on page 2.

*Automator and other system softwares have updated or become available since 10.4.0. There is
a very very small number of features which may not work as described under early releases.
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Installation and Configuration
1) Run the installer. If your distribution does not contain an installer, move the
Accelerando application into the primary Applications folder:
/Applications/
Important: No location other than /Applications is supported.
2)
3)
4)
5)

Launch Accelerando
Register Accelerando
Configure System Preferences if prompted
Launch Automator while holding the option key

Automator should now contain Actions under categories 'Accelerando', 'Apple Loops
Utility', and so on..
If Accelerando’s Actions are still not displayed, a restart may be necessary for OS
X to register all components.
At this point, you are able to run Accelerando’s Actions as you would any other
Action.
Important: The application Accelerando needs to be running while using Accelerando’s Actions. The actions cannot be performed without Accelerando.

Uninstalling Ac c elerando
If you ever need to uninstall Accelerando, simply move the Accelerando application
to the Trash and empty.
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Registration
Registration is available directly from the Accelerando application. If a valid Serial
Number is not found at launch, you will be asked if you would like to Register
Accelerando, Exit, or enter a Serial Number.
Choose 'Register' to purchase a license for your machine. The purchase process
will require an internet connection and a credit card. Once you have registered,
relaunch Accelerando.
If you are asked to register at launch and have have already registered, you can
choose “Serial Number…” to reenter your Serial Number. You may also use this
method to register your secondary user account on the machine.
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Notes on future development
January 09, 2007 ~ Before Accelerando was available for sale
Since Accelerando was released late in Tiger’s life-cycle, Accelerando is not projected to hit full stride and stability until OS X 10.5 (Leopard).
There is much one can do with Accelerando’s current features, but the software is
planned to adopt Leopard very quickly and settle in under Leopard.
Tiger releases will continue beyond 0.81 Beta, but Accelerando will migrate quickly
for technological, development and support reasons.
If you purchase Accelerando now, your license will be upgraded to the initial
Leopard release when you are ready.
Stability and features will be added to 10.4 releases but only for a limited time.

July 26, 2007 ~ In preparation for Accelerando 0.9
As this release shows, Accelerando is going through several changes.
In Accelerando 0.81, Synapse performed several functionalities and had a User Interface. Synapse no longer performs any functions which require a user interface.
As of Accelerando 0.9, Accelerando (the application) contains the user interfaces of
both Accelerando.app 0.81 and Synapse.app 0.81.
Further sizable interface and functional changes are planned and should be expected.
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Changes & Additions since 0.9.0
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The Preset Manager
The Preset Manager o!ers a very streamlined way to access presets for many of
Accelerando's Actions. By using the Preset Manager, you can eliminate much of the
time it takes to configure Accelerando's actions since you can store and recall settings for an action very easily. Once you have a Preset Library that you know well,
you can configure most of your actions and workflows using the Preset Manager.
The base System preset directory is located at:
/Library/Application Support/Accelerando/Action Presets/
Similarly, the base User preset directory is located at:
/Users/your_account/Library/Application Support/Accelerando/Action Presets/
Each preset is individually stored on the filesystem. A Scope is a formula which
the Preset Manager uses, that helps determine where to Load and Write presets
from.
The Preset Manager operates within the scope of an Action and the Action's title
is used to extend the preset directory based on this scope. Therefore, if you are
using the action 'Perform Link', the directory Preset Manager saves to and reads
from will be:
/Users/your_account/Library/Application Support/Accelerando/Action Presets/Perform
Link/
Finally, some Actions work within subdirectories of this folder, based on the parameters the use. For example, the Action Position Window uses a subdirectory for
each application. Such as:
/Users/your_account/Library/Application Support/Accelerando/Action Presets/Position
Window/Finder/
/Users/your_account/Library/Application Support/Accelerando/Action Presets/Position
Window/Accelerando/
In this case, you will need to define the application you wish to use the action
with by entering the application's name into the Application parameter field. Once
the application has been defined, Preset Manager automatically populates the list
with the presets it finds in that subdirectory - which represents the current scope.
The Preset Manager has 7 controls. From left to right, they are:
1) The Domain Switch
2) The Preset Title Entry Field
3) The Write Button
4) The Load Button
5) The Save… Button
6) The Open… Button
7) A popup menu
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The Domain Switc h
The Domain Switch toggles the base directory from which Presets are read.
A setting of U (for the User Domain) will read from the directory:
/Users/your_account/Library/Application Support/Accelerando/Action Presets/
A setting of S (for the System Domain) will read from the directory:
/Library/Application Support/Accelerando/Action Presets/

The Preset Title Entry Field
The Preset Title Entry Field is used for both loading and saving your presets by
their titles. It also lists the available presets will attempt to autocomplete your entries based on the presets that are saved. The available presets are dependent on
the scope that the Preset Manager is working in. This scope corresponds to the
directory that is determined by the Preset Manager as well as your settings, such
as the Domain Switch and the action that is used. As previously mentioned, some
actions work within subscopes which are based on your entries. If you are using
an action which requires a subscope, you will have to set the appropriate parameter before you can use the Preset Manager's loading and saving functionalities for
that subscope. If you were working in Automator and added a Select Menu Item
action, you would need to enter "Finder" in the Application parameter to cue the
Preset Manager which scope you are using. After you have entered any required
parameters, the Preset Title Entry Field will populate with the Presets it finds
within the scope.
It's a good time to mention that there is a default behavior in place for several
subscopes. In this example, the application is a required parameter which is used
to determine Preset Manager's scope. If an appropriate subscope is not found
based on your settings, Preset Manager defaults to one of these directories:
/Users/your_account/Library/Application Support/Accelerando/Action Presets/Select
Menu Item/Unknown Application/
/Library/Application Support/Accelerando/Action Presets/Select Menu Item/Unknown
Application/
This behavior can be useful in it's own right. First, it keeps your presets managed
more appropriately by not overpopulating a specific scope. Also, it allows you to
use Preset Manager for templates. Since we used Select Menu Item in this example, you could make templates for menu items which are consistently found in OS
X. For example, the edit menu typically contains commands for Cut, Copy, Paste,
Select All and so on. If you saved templates for these items within the 'Unknown
Application' scope/directory, you could recall the template preset, define the Application (which would change the scope), and then write the preset. Since the application was redefined, the scope changes, and the write operation will be performed under the newly assigned application's scope. This makes preset creation
very fast.
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The Write Button
The Write or Overwrite button saves the current settings within your presets folder
(regardless of the Domain Switch setting), based on the active scope, using the
title which is entered in the Preset Title Entry Field.
If the value you have entered in the Preset Title Entry Field matches an existing
preset, the title of this button becomes 'Overwrite'. If you press 'Overwrite', the
preset will be overwritten without confirmation.
Illustration:
To write a Copy Text to Pasteboard Preset, add the Copy Text to Pasteboard action to your workflow, enter 'My first preset' into the Preset Title Entry field, then
press 'Write'. The Preset should be written to:
/Users/your_account/Library/Application Support/Accelerando/Action Presets/Copy Text
to Pasteboard/My first preset.accelpreset
When you want to recall the preset, type the first few letters of the preset into the
Preset Title Entry Field, let autocompletion complete your entry, then press 'Load'.
This assumes you have the Domain Switch set to 'U'.

The Load Button
The Load Button becomes active when Preset Manager matches your entry with a
saved preset, within the current scope. When the Load Button is pressed, the saved
preset replaces the parameters the action. If the entry in the Preset Title Field is
not an exact match for a preset in the current domain but is an exact match in
the other domain, the Load button will become active and indicate that the preset
you are loading comes from the other domain by enclosing the first letter of the
domain in parentheses.

The Save… Button
The Save… button allows you to save the current settings someplace other than
the current scope. All Actions use the 'accelpreset' extension. If you save a preset
outside of the current scope, you'll probably want to label it or organize it in a
way which indicates to you which Accelerando action created it, and can therefore
read it.

The Open… Button
The Open… button allows you to open a preset from someplace other than the
current scope. Nothing will happen if you choose an incompatible preset for the
action.
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A popup menu
This popup menu contains less frequently used functions for Preset Manager. Presently, this menu reveals the preset directories.
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Key Commands window
The Key Commands window allows you to assign many of Accelerando's functionalities to a Key Command. Not only does it allow you to perform functions from
Accelerando's menus, it allows you to assign one of several actions to a Key
Command. The Key Commands editor does not usually get into the low level specifics of tasks, many of the actions in the Key Commands window simply provide
a higher level mechanism to invoke another object, such as run a script or workflow which has already been saved on your Hard Drive.
To open the Key Commands window, select the menu item from Accelerando's
Main Menu: Window > Key Commands
Accelerando uses a document located at:
/Users/your_account/Library/Application Support/Accelerando/Key
Commands/Accelerando.ERKeyCommands
Accelerando should create this document for you the first time it is needed. The
default Key Command set defines primarily Accelerando's menu items (with assignments), so you shouldn't have to define many of these yourself though you
may want to reassign the key equivalent used.

Command Assignment
A Command Assignment refers to the top level object which contains all attributes
necessary to specify a single assignment. It contains unique places for a command
identifier, arguments, modes, availability level, key command assignment and so
on.

Command Identifier
The Command Identifier is an attribute of a Command Assignment which allows
you to give your assignments a label or title. It does not a!ect functionality, but
allows you to keep your Command Assignments organized.

Command Availability
The Key Commands window o!ers three levels of availability:
1) Within Accelerando (the application). Assignments in this category are available
when Accelerando is the frontmost application.
2) Globally. Assignments in this category are available System wide. If you assign a
script to Command + F1, pressing Command + F1 will run the script regardless of
which application is in front.
3) The third is simply 'Disabled', although there is an dedicated way to disable a
Key Command from registering.
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There are a few caveats when using Global Key Commands:
1) When you assign a Global Key Command, the System attempts to reserve them.
These Key Commands will not be available in application specific contexts. If an
application would have used Command + F1 but it were assigned Globally, the Key
Command would obviously no longer be available in the application.
2) Multiple Applications can register the same Key Command on a Global basis. In
this case, both applications will typically receive the message.

Ac tion
Each Command Assignment contains a field for you to specify it's action. Presently,
these actions are:
1) No Action
2) Accelerando Menu Item
3) Launch Application
4) Open Launch Path
5) Perform Link
6) Perform Link at Absolute Path
7) Shell Command
8) Open File
9) Open File using Application
10) Reveal Location in Finder
11) Run Workflow with Title -- This is not implemented
12) Run Workflow at Window Index
Descriptions and usage can be found later in this chapter.

Arguments
Each Action requires additional information in order to produce a result. For example, if the action is set to 'Launch Application', you'll need to specify an application or a path to an application. The Key Commands window provides up to two
fields for you to enter arguments, this number depends on the action you have
selected.
Full descriptions and usage can be found later in this chapter.

Key Commands Window Layout
Command Assignments Table
The Key Commands window presents all of your Command Assignments in the table of the left. Functions specific to all Command Assignments or creation or removal of Command Assignments are found directly below the Command Assignments table.
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The Command Assignments Table has 3 columns. The first contains an On/O! button so you can easily disable or re-enable a specific Command Assignment. The
second column displays the key equivalent. The third column displays the Command Identifier. Remember, the Command Identifier exists solely for you to manage your Command Assignments more easily.
A Search Field in the upper right corner of the window allows you to filter the
Command Assignments in the Command Assignments table. By clicking on the
magnifying glass icon, you can specify which criteria you would like to search by.
The default behavior matches your entry against the Command Identifier.

Command Assignment Detail Fields
The fields to the right of the Command Assignments table provide details for the
selected Command Assignment(s). Functions specific to selected Command Assignments are found directly below the argument fields. These fields update dynamically based on the selection in the Command Assignments Table.
From top to bottom, the available fields are:
1) Command Identifier
2) Availability Selector
3) Action Selector
4) Zero, one or two argument fields. The number is based on the selected Command Assignments and their respective Actions.
Creating a Command Assignment:
This demonstration walks you through the process of assigning Command + Control + Option + A to launch Automator.
1) First, you will need to open the Key Commands window.
2) Press the 'New Command' button located in the lower left corner of the Key
Commands window. This creates a new Command Assignment. The new empty
Command Assignment has no assignments, other than a Command Identifier 'New
Command'. This Command Identifier will typically be selected in the Command Assignments Table when it is created. If it is not selected or if you have multiple
Command Assignments selected, make sure only the new Command Assignment is
selected.
3) Label the Command Identifier 'Launch Automator'.
4) Click and hold the Availability Selector and choose Global. This specifies that
this Command Assignment is available whenever Accelerando is launched.
5) Click and hold the Action Selector and choose Launch Application to indicate
that behavior.
6) You can either enter the full path to Automator, or simply enter 'Automator'
into the arguments field, which is labeled 'Path to or name of Application:'. Specifying a full path will be a little faster when you perform the key equivalent, and it
can reduce confusion if you have multiple applications with the name 'Automator'.
The most obvious occurrence of this is if you have 2 boot volumes. If you don't
specify a full path, there is the possibility that the Automator application that is
not n your boot volume will be launched. You are often able to set arguments by
drag and drop.
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7) Now that the action is configured, all we have to do is assign the key equivalent. Press the Assign Key Command button, an indicator above the Command Assignments Table should begin to show you that it is listening for your next entry.
Enter Command + Control + Option + A. The indicator should stop and the second
column of the Command Assignments Table should change from 'None' to Command + Control + Option + A (using the appropriate glyphs).
8) Before changes take e!ect, you'll need to Save your Key Commands document.
Remember, Key Commands that Accelerando uses for it's menu items will not actually take e!ect until the next time you launch Accelerando. That's not the case
in this example, but it is a source of confusion.
9) Now that you have saved your document, you can test the Command Assignment. If Automator is launched, it will be activated, otherwise it will be launched
and will take a few moments to display.
10) If you don't want to keep this command assigned, just click the button in the
left column of the Command Assignments Table and re-save the document.

Configuring a Command Assignment' s Behavior
Each action you can assign using the Action Selector requires a small amount of
configuration. As usual, Accelerando tries to make most things fast and powerful.
The idea behind the Command Assignment's Actions is that you'll usually want to
leave the larger implementations to a dedicated file. Though you could have a
Command Assignment run literally hundreds of Automator workflows or build multiple Xcode projects all at once by using a very long Shell Command, it is recommended that you put these larger implementations into a dedicated respective file
and then have the Command Assignment run the file that contains all the details.
For the example of several workflows, you can create a workflow with Automator
and use the Run Workflow Action. You then save that macro workflow and tell Accelerando to run the macro workflow. Otherwise, the task overhead and Key Command Assignment file can get out of control rather quickly. It really wasn't designed to be Automator or Terminal, as well as potentially hundreds or thousands
of Shell Scripts and Automator workflows all wrapped into one document - that is,
your Accelerando.ERKeyCommands document. Additionally, it is safer and more
portable to store these workflows and scripts as separate documents.

Conventions of Ac tions and Arguments
Several Actions accept multiple arguments. Multiple Arguments, where applicable,
can be assigned by separating each argument with a new line. Multiple arguments
are not guaranteed to occur in a particular order - nor does Accelerando guarantee that it will be able to properly translate what could possibly be entered. You
should think of Multiple arguments as a bonus feature, if they work for your
needs. They are not designed to o!er every last detail or control and if what you
want to invoke relies on this behavior, make life easy and use the proper tool for
the job - such as a Shell Script or Workflow which you have saved and configured
for your needs.
An easily overlooked error can be introduced if you enter a leading or trailing
space in an argument field. Accelerando has a very specific behavior in this regard, and it does not attempt to resolve such di!erences for your safety.
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1) No Action
Action: Does nothing when invoked by Key Command
Supports Multiple Arguments: N/A
Arguments: N/A
Other Notes:
!
2) Accelerando Menu Item
Action: Allows you to assign a Key Equivalent to any of Accelerando's Menu Items
Supports Multiple Arguments: No
Arguments: The title of the Menu Item, exactly as it appears
Other Notes: Most of these will be assigned automatically when the default key
command set is created. Changes take e!ect next time you launch Accelerando.
3) Launch Application
Action: Launches an application
Supports Multiple Arguments: Yes
Arguments: Either the name of the application or the full path to the application.
Other Notes: By using full paths, you can improve response as well as specify
which application to launch if you have more than one application with the title
you have entered - this typically happens if you have multiple boot volumes.
4) Open Launch Path
Action: Opens the entered path as a Launch Path
Supports Multiple Arguments: Yes
Arguments: Either a full or resolvable path
Other Notes: See the section on Launch Paths for the expected behavior. This
functionality replaces the need for the Launch Paths windows that were found in
early versions of Accelerando.
5) Perform Link
Action: Performs the Link at the specified subpath
Supports Multiple Arguments: Yes
Arguments: The subpath to the Link(s) to run
Other Notes: See the section on Links for the expected behavior.
6) Perform Link at Absolute Path
Action: Performs the Link at the specified absolute path
Supports Multiple Arguments: Yes
Arguments: The absolute path to the Link(s) to run
Other Notes: See the section on Links for the expected behavior. This action is a
good choice if you change your Links Directory frequently.
7) Shell Command
Action: Sends the entered text (script/command) to be interpreted by bash under
default login.
Supports Multiple Arguments: N/A
Arguments: A bash compatible shell script or command
Accelerando User’s Guide!
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Other Notes: This is good for simple commands. No error or output is attempted
to be presented by Accelerando. This is still a new feature, if you experience unexpected expansion (which is possible), please file a bug report.
8) Open File
Action: Opens a file in the application that would open it if you had double
clicked on it in Finder.
Supports Multiple Arguments: Yes
Arguments: A full or resolvable path to a file
Other Notes:
9) Open File using Application
Action: Opens a file in the specified application
Supports Multiple Arguments: Yes
Arguments: A full or resolvable path to a file
Other Notes:
10) Reveal Location in Finder
Action: Displays the location in a Finder Window.
Supports Multiple Arguments: Yes
Arguments: A full or resolvable path
Other Notes: This is not guaranteed to happen one way or the other. Finder determines whether a new window will be created, and can have di"culties displaying some locations which are obscured or hidden.
11) Run Workflow with Title
Action: This is not implemented
Supports Multiple Arguments: N/A
Arguments: This is not implemented
Other Notes:
12) Run Workflow at Window Index
Action: Runs an open workflow in Automator
Supports Multiple Arguments: No
Arguments: An integer value
Other Notes: This is behaviorally synonymous with to 'Run Windowed Workflow…'.
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Ex ternal Editor Utility
A new application is available in the Accelerando suite called ‘External Editor Utility’. In simple terms, this application acts as a reference for another application.
When a file is opened with External Editor Utility, External Editor Utility redirects
that request to the object at the path you have specified External Editor Utility to
open files using. This allows you to easily redirect files to be opened by an application or sent to a script within a scriptable environment. Reconfiguring an application's preferences (for example) can limit the potential of external editors, especially in the context of a script. External Editor Utility can reassign it's reference
on the fly and Accelerando includes Automator Actions to Set the External Editor
Utility Reference. The Automator Actions that change this reference are 'Set External Editor Utility Reference' and 'LP-Set External Sample Editor' (v. 0.9.2 or greater).
External Editor Utility is intended to be generally compatible with any application
or file type. For example, it can be used to alternate default external sample editor or text editor.
Configuring External Editor Utility is simple. In this example, we'll assign a pdf
document to be opened with External Editor Utility.
1) Install External Editor Utility
2) Open Automator and Accelerando
3) Add the action 'Set External Editor Utility Reference' to a new, empty workflow.
4) Set the action's parameter to QuickTime Player
5) Run the workflow
6) Drag a pdf onto External Editor Utility. The pdf should open in QuickTime
Player.
7) Back in Automator, set the action's parameter to Preview
8) Run the workflow
9) Drag a pdf onto External Editor Utility. The pdf should now open in Preview.
As you can see, redirecting documents to be opened in an application is easy. You
can also use this utility to redirect multiple files to di!erent scripts or workflows
(saved as applications). By using External Editor Utility, you only need to redirect
what script or application External Editor Utility points to, you can then easily perform very complex automations with minimal configuration because you only need
to configure where External Editor Utility directs the files it receives and then the
files will be sent to the script or application that actually does the work. This
makes it easier to manage complex automations using a more manageable library
of scripts - a frequent alternative is a workflow or script that is several times
longer and far less reusable.
Logic Users, here is an excerpt that was posted at www.eigentoneresearch.com
when External Editor Utility was introduced:
To configure the use of External Editor Utility:
1) Install External Editor Utility
2) In Logic Pro, choose the menu item: Logic Pro > Preferences > Audio
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3) Select the Sample Editor tab
4) Select the ‘Set’ button below the box labeled ‘External Sample Editor’ and navigate to External Editor Utility in the open panel that follows. Files will be opened
by External Editor Utility when you choose the Logic Pro menu item: Options >
Audio > Open in application_name. At this point, the menu item should be titled
‘Open in External Editor Utility’.
5) Now that we have configured Logic to point to External Editor Utility, we must
configure External Editor Utility. This is presently handled by the Automator action
‘LP-Set External Sample Editor’. LP-Set External Sample Editor now sets External
Editor Utility’s reference (for use with Logic 8) in addition to the Logic 7 behavior.
6) Verify Accelerando is launched. Accelerando must be running for External Editor
Utility to work properly.
Now External Editor Utility is ready for use. Just select Logic Pro’s menu item
‘Open in External Editor Utility’ and the files should be directed to the application
you have set with LP-Set External Sample Editor.
Q: “What is wrong with the way it works from Logic?”.
A: Nothing is wrong with the way Logic handles the procedure. However, this approach allows an easy way to handle setting the external editor from within a
workflow or script for incredible power and convenience and there is no reason
this feature should not be removed. There are users who will want to be able to
change the external editor or the script or workflow it points to as well as maintain behavior of their existing workflows.
By using this functionality in your workflows, you can set an actual application to
open the file for editing or use it to point External Editor Utility to another script
or workflow.
An example use that touches the surface of the potential: Soundtrack Pro is now
included with Logic 8. Soundtrack Pro allows you to export AppleScripts. Use External Editor Utility to point any of these scripts on the fly (from workflows accessed via Links) for preset based processing - similar to Process in Place. Without
External Editor Utility, one would have to configure the behavior/preferences many
times per day or manually call the functions several times per day from the external editor. The workflow accessed via Link can of course wrap preflight and postflight key commands or basically any other action so there is much potential
available.
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New Automator Ac tions
Since 0.9.0, was released 12 new actions have been introduced. For now, please see
the info box in Automator for usage of these actions.
The new Automator Actions are:
A-Activate Accelerando
A-Fast Iterate 3
A-Fast Iterate 9
A-Key Command
Click at Position
Position Cursor
Scroll Wheel
Set External Editor Utility Reference
SP-Activate Soundtrack Pro
SP-Fast Iterate 3
SP-Fast Iterate 9
SP-Key Command

Leopard Complianc e
Several incremental updates are planned to make the transition to Leopard as
smooth as possible. Version 0.9.6 is the first public version for Leopard. If you are
using Leopard, the latest version is generally recommended but anything below
0.9.6 is not recommended or supported for use with Leopard. Leopard’s delay from
spring 2007 to October 2007 kept much of Accelerando’s development focused on
and compliant with Tiger.

Tiger Complianc e
Accelerando is still fully compatible with Tiger.
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Conceptual Introduction
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Sec tion Overview
‘Conceptual Introduction’ introduces Accelerando and Automator. It also o!ers
some pointers for people who may be new to other related areas of scripting and
automation.
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What is Ac c elerando?
Accelerando is a collection of several utilities which have been designed to allow
you to accomplish common tasks easily and quickly.
Accelerando’s utilities are made available via 2 primary interfaces:
1) Accelerando (the application) allows you a direct access to your scripts, applications and workflows. For example, you can run a workflow, open a shell script for
editing, launch an application by name, enter a bash command, or go to a frequently visited location in Finder.
Accelerando has been designed to provide all this and more with the shortest path
in mind, while retaining universal compatibility and very high flexibility for you.
The high level of interaction and organization provided by Accelerando allows you
to run a saved script with minimal e!ort.
2) Automator Actions. Many of Accelerando’s tools are provided in the form of
Automator Actions. This allows immense interoperability with other software and
tasks. Accelerando’s Automator Actions are designed to be very easy to understand and quick to configure. They are flexible enough that users with no scripting experience and experienced users alike will benefit from their capabilities.
Accelerando o!ers a universal support model so you can use it’s Actions with
most applications.
Accelerando makes things even easier by o!ering Automator Actions which target
specific applications. These Actions allow you to configure a more reliable workflow in less time. Speed and configuration time has been a major weight when designing Accelerando’s User Interface.
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What is Automator?
Automator is an application by Apple which is provided with every license of OS X,
beginning with 10.4.0 (Tiger). Automator was chosen as the hub of much of Accelerando’s programming interface because it is available to everybody and integrates
very well into OS X’s larger scripting model. Automator o!ers an open interface,
which allows users much freedom to configure the workflow they desire. Since any
developer may create Automator Actions, interoperability is significantly increased
because the Actions will typically speak a ‘common language’.
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Hundreds of Automator Actions are available today by many developers for applications in most software categories. No prior scripting experience is required to
begin making valuable workflows. There is no need to learn the ‘language’ of one
or several scripting interfaces in order to begin scripting.
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Considerations when c reating a workflow
Consider how much time it takes you to enter commands when creating your
workflows. You are able to send unreal amounts of commands per second with
Accelerando, this could ultimately result in data loss or unexpected errors such as
missed or misdirected commands. By using Accelerando, you can often enter
commands (safely) and run workflows several times faster than you can enter
them yourself but do allow some time between steps. Accelerando was designed
to manage multiple tasks and run them very quickly. Because it does not assume
a particular behavior, you may need to adjust delay times between steps or take
other measures to make sure the workflow will not cause problems.
Accelerando enables you to do things more quickly and reliably, but this may require a well crafted workflow. Under good conditions and using a modern computer the fastest you can expect a key command sequence to execute is around 5
milliseconds per key command (200 key discrete key commands per second). This
measurement was made using Fast Iterate 9 to simulate typing. Naturally, if you
invoke a key command such as ‘Save’, it may take the application that recieves
the event much longer than 5 milliseconds to save your document. Sometimes, the
application will ‘drop’ or ignore events it cannot process. Many of these key commands are stored as they are received, then performed in the order they were received. You can usually send thousands of key events without delay to a text editor without problems, though the text editor will require time after the action is
finished to complete the text entry.
There are a few options to overcome this. One is to use delay between commands.
Another option is to break a workflow into smaller pieces or use another action to
stop the workflow at certain points.
Workflows can be created as entities or as a macro or building block to be used
within larger workflows. Additional time will be consumed when moving from Action to Action or Workflow to Workflow. This should be determined by the user
when the workflow is created.
The principles are easy to learn once you know the limits and after a few successes creating subsequent workflows will often be very easy. Remember, these
limits may adjust based on system tasks, which are di!erent when you run a
workflow at a time after you created it.
Accelerando has been designed for users who have a good understanding of OS X
and the applications they wish to control. It was built for speed, for people who
want to work faster or have several redundant tasks every day. Therefore, several
obtrusive behaviors have been omitted, such as Automator reminder/warning messages. Users are expected to understand how this software works before using it
extensively. Each Action has a description which states typical requirements, caveats, or issues which can help new users along the way.
There are things you should ensure before running. For example:
1) Which window of which application will receive commands in a Key Command
based Action?
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2) Is the current editor the editor you intend to target?
3) If you are using Accelerando to enter text, will the Action replace selected text
when you do not intend it to?
These are additional steps that you may want to program into your workflow to
reduce unwanted results. You can often use Accelerando to bring a specific window to the front, deselect text or position the caret.
Many applications aren't designed for such scripting, user interference may cause
unexpected behavior such as commands or events sent to another application. The
key is which application, text field, etc. has focus while the script is running. Some
Actions require proper focus for targeting - if you switch applications or change
the current editor, commands may be received by the new editor. If the targeted
application is receiving events faster than it can process them, the stored events
may be ignored once the application is switched. Test and debug your workflows.
Accelerando is easy to use, much can be accomplished once you are familiar with
the concepts of scripting in this manner.
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Performanc e Notes
When using LP-Fast Iterate 3 on a small session (Logic Pro, G4) the ideal time for
recalling 3 screensets in Logic in sequence was 200 ms, although the workflow
could execute many times faster. In this example, the bottleneck was Logic needing time to draw the new windows.
When using TM-Fast Iterate 9 (TextMate, Intel Core 2 Duo), 999 keystrokes were
transmitted in about 2 seconds - which is approximately 8 times faster than text
can actually be entered. This test used all 9 fields and had a repeat setting of 111.
Each field contained a single character. No commands were 'dropped'. In this test,
the virtual typing was bu!ered and the keystrokes continued several seconds after
the workflow completed. Not every application will handle commands so well.
Trick: Although it is not o"cially supported beyond Special Keys, multiple characters can be entered into a single ‘Key’ field of key command based actions.
These additional entries will be performed in sequence without delay.
The primary reason it is not supported is that Special Keys may be added in the
future. In that event, the command will be interpreted as a Special Key and your
workflow will not run the same.
Another reason is that some character combinations will be interpreted di!erently. In this event, your entry will either not be what you expected or will cause
a syntax error.

Accelerando User’s Guide!

36

Accelerando Reference
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Sec tion Overview
‘Accelerando Reference’ describes the usage of Accelerando the application. Accelerando o!ers several ways to manage a very large or small collection of many
types of files and executables through it’s task based windows.
If you are new to scripting, you may find Automator, workflows and perhaps Applescript in combination with the Search Window and Launch Paths your tools of
choice.
The Search Window provides an overview of your library of scripts, workflows and
other recognized types of script based files. From the Search Window, you can
easily run, delete, reveal and open any script in your Library.
Accelerando has multiple task based windows and editors. Using these, you can
access Finder Locations, Launch Applications, Perform Links, Run Workflows which
are open in Automator, or enter shell commands.
For power users, Accelerando o!ers many additional options, the most powerful
concept is likely Links. Links allow you to run several types of scripts, workflows,
or executables based on a user defined working directory. If you have a Shell
Script (for example) in your Links Directory, all you need to do to run it enter it’s
name. Since you can manage the any Links Directories however you please this
puts potentially thousands of scripts literally keystrokes away.

Accelerando User’s Guide!

38

Searc h Window

1

2

4

3
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Accelerando’s Search Window allows you to access, open, or run several types of
documents, scripts and applications. Accelerando allows you set a ‘Search Directory’. By default, this location is:
~/Library/Application Support/Accelerando/Workflows
The intended use is to create a library of scripts and workflows. By using a central
default location, you can use ‘Accelerando PlugIns’ to quickly add workflows to
your script library. If you already have a library, you can set the Search Directory
to any directory you like by using the ‘Set Search Directory’ window
When Accelerando is launched, it performs a search of your Search Directory and
displays the Search Window. If you would like to restrict the types of files or
scripts sought, you can do so from the Preferences window.
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Compatibility Note: The Search Window uses Spotlight technology. If you have
disabled Spotlight’s services, you will need to enable them in order to use the
Search Window.

Table Content
Double-Clicking an Application or Workflow will execute it.
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Searc h Menu
The Search Menu is located in the Accelerando’s Menu Bar. It o!ers several functions which relate to the Search Window.
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Toolbar Items
The Search Window’s Toolbar functions like toolbars you find throughout OS X. It
allows you to place and order several functions at the top of the window.
All items are intended to be displayed as text (no icons at present). To conserve
space, the Toolbar items use abbreviated titles. All items are available via Key
Command or a dedicated window.
The Toolbar functions are:
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The many ways to open the Toolbar Customization Palette:
Control + click a space in the toolbar
Command + Option click the toolbar’s show/hide button
Press !" T
Choose it from the Main Menu
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Launc h Paths
LEGACY NOTE: The Launch Path windows are being removed. The Key Commands
window allows you to reproduce this behavior more flexibly and without the necessary clutter.
Accelerando provides 20 Launch Paths for you to work use. Launch Paths allow you
to open applications, documents, files or display locations in Finder.
All Launch Paths are invoked, or opened by their numeric reference. Launch Paths
can be opened by Key Command, the ‘Open Launch Path’ display.
Launch Paths may also be placed in a window’s toolbar !" T. Launch Paths are
labeled by number when placed in the toolbar, as seen below.

Example: Assigning your first Launch Path
1) Select ‘Actions > Configure Launch Paths’ from Accelerando’s Main Menu.
2) Enter /Applications/iTunes.app into Launch Path field 1 as displayed below.

The Launch Path is now configured and ready to use.
3) Whenever you enter ‘1’ into the ‘Open Launch Path’ display or press

!" 1 iTunes will be activated.
Launch Paths have di!erent behaviors, depending on what exists at the path.
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Tip: If you would like a di!erent behavior, consider using Automator to save a
workflow as an application. You can then have the convenience of Launch Paths
with the ability to perform multiple actions using a single invocation.
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Links
Links o!er an extremely streamlined and powerful method for invoking or running
your Applescripts, Shell Scripts, Workflows and other executables such as Workflows or Applescripts which are saved as applications. By using Links, you can invoke any supported file or executable format by entering the name you saved it
as.
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Links are entered using the Perform Link window. When you enter a Link in the
Perform Link window, Accelerando uses the following formula to compose your request:
Links Directory + entry + extension
Using this formula, you can easily navigate a very large library of Scripts, Applications and Workflows - all items labeled and ordered as you prefer. Naturally, short
names will be most convenient for frequently accessed Links.

Example: Creating and running your first Link
This example assumes Automator is not open in the beginning.
This example also assumes you have not modified your Search Directory or the
Links Directory. If you have modified them, you can reset them for this example
by setting the Search Directory and Links Directory to:
~/Library/Application Support/Accelerando/Workflows/
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Note: The tilde ~ at the beginning of the path indicates your Home folder:
‘/Users/your_user_account’
So the full path would be:
‘/Users/your_user_account/Library/Application Support/Accelerando/Workflows/’
where your_user_account is replaced by your user account name.
First, we will create a workflow which Activates Finder.
1) Launch Automator - Automator creates a new empty workflow at launch.
2) Enter ‘FDR-Activate Finder’ into Automator’s search field like so:

3) Automator removes every Action in the Action column that does not relate to
the entered text. In this case, the only option in the Action column is ‘FDRActivate Finder’. Double-click on ‘FDR-Activate Finder’. This will add the Action to
the workflow.
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Double Click here to insert the Action
Your workflow will now look like this:

4) In Automator’s main menu, select ‘File > Save as Plug-in…’. A save dialog will
be presented.
5) In the ‘Save Plug-in as…’ dialog, set the value of the ‘Plug-in for:’ option to
‘Accelerando’. Also, set the ‘Save Plug-in As:’ field to ‘f’ as shown.

6) Save. Your workflow is now saved as:
~/Library/Application Support/Accelerando/Workflows/f.workflow
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7) In Accelerando, press F1 or select the menu item located at ‘Actions > Perform
Link…’. The Perform Link window will open.
8) Enter ‘f’ in the Perform Link window.

9) Press Return or click the Ok button. Finder should activate at this point.

Using this example, we can dissect the formula for performing a Link:
Links Directory + entry + extension
In the example, the Links Directory was
‘~/Library/Application Support/Accelerando/Workflows/’
The entry was
‘f’
The extension in our example was ‘.workflow’
So Accelerando knew you sought:
~/Library/Application Support/Accelerando/Workflows/f.some_extension

some_extension is always determined by Accelerando, based on what it finds in the
Links Directory - you do not need to enter the extension when performing a Link.

Example: A side e#ect of invocation by multiple formats
Since Accelerando determines the extension when a Link is performed, there is the
chance that the result is not what you were expecting if your request matches the
title of multiple items in the Directory you have specified.
Let us assume you have the following 5 files are in the Links Directory:
run.app
run.applescript
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run.scpt
run.sh
run.workflow
Of course, many things could happen when the Link ‘run’ is performed. What actually happens is only the first match is run. Additionally, the ‘first match’ is not
guaranteed to be consistent now or in future releases.
The trap is that you are allowed to save and move files freely, though Accelerando
will neither warn you nor attempt to make the distinction when a Link is performed. The solution is to rename them so they all have unique names.

Navigation with Links
If the Link you enter is not in the directory it has been pointed to, the Link will
not be run. You may specify a subdirectory or a parent directory in the entry, but
Link matches do not search recursively.
If you want to perform a Link which resides in a directory other than the Links
Directory and do not wish to change the Links Directory, the following conventions
may be used:
Subdirectories may be specified with ‘/’ (slash)
Parent Directories may be specified by ‘../’ (period+period+slash)
Suppose the Links Directory is ‘My Links’ in the picture below.

To run run.sh without changing the Links Directory, enter ‘../run’.
Using the same photo, let us say the the Links Directory is the parent directory of
‘run.sh’, you would then enter ‘My Links/0’ to run ‘0.workflow’.
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Starting points for c reating Links
In the example ‘Creating and running your first Link’, you created a workflow
which activated or launched a specific application. You can extend this concept to
activate your most frequently accessed applications using any abbreviation you like
so they may all be accessed within a few keystrokes. Since links support several
formats, you could use the Automator Action ‘Launch Application’, Shell Scripts, or
Applescripts to activate any application you like.
After that, you may want to do the same for your frequently accessed documents
and websites. If you expect to create a large Links library, you may run out of
memorable short names, At this point, you may want to put all websites in a directory named ‘w’ so you could run a workflow named ‘er’ by entering ‘w/er’.
Of course, none of the supported formats are limited to one action - you could
make a Link called ‘news’, which opens all your favorite news websites.
Links are a very convenient way to manage and run a very large or small library
of scripts.
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Advanc ed Link Topic s
Using a unique Links Direc tory
For maximum flexibility, Accelerando o!ers multiple operational modes while using
Links.
By default, the Links Directory is located at:
~/Library/Application Support/Accelerando/Workflows/
Additionally, the Links Directory is tied to a Preference named ‘Use Search Directory’ - which is enabled by default. With this Preference enabled, the Links Directory equals your Search Directory.
To set a unique Links Directory:
1) Open the Preferences window. Disable the preference ‘Use Search Directory’.
2) Open the ‘Set Links Directory’ window by pressing $ F1
3) Select or create the directory you wish to use as your Links Directory.

Navigating Large Libraries with Links
If you use a unique Links Directory or don’t mind switching the Search Directory
frequently, you can achieve additional convenience by grouping your Links into directories which are built around frequently used sets of scripts. This way, you can
reduce the amount of typing by using tiered sets designed for specific tasks.
For example, if you have several emails to write, you may have many text blocks
(sentences, paragraphs, signatures or hyperlinks) which you created with the ‘Copy
Text to Pasteboard’ Action saved as workflows. If you save all Links to one directory you can access them more easily by simply changing the Links Directory
while working on that task.
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Preferenc es
LEGACY NOTE: T h e G l o b a l K e y C o m m a n d s s e c t i o n h a s b e e n r emoved. See the section on the Key Commands window.

1
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3
4

5
6
7
8

9

10

11
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Go to Folder
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Launc h Applic ation
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Configure Launc h Paths
LEGACY NOTE: This window will be removed, it is being replaced by the functionalities of the Key Commands window and Links.
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MiniTerminal
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Open Launc h Path
LEGACY NOTE: This window will be removed, it is being replaced by the functionalities of the Key Commands window.
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Perform Link
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Run Windowed Workflow
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Set Links Direc tory
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Set Searc h Direc tory
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Ac c elerando Key Commands
LEGACY NOTE: Fixed Key Command assignments have been removed. Refer to the
section on the Key Commands Window at the end of this guide.
This is a partial listing of Accelerando’s Key Commands.
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Ac c elerando PlugIns
This function allows you to save your workflows directly to Accelerando's default
Search Location directly from Automator.
1)
2)
3)
4)

Open a workflow in Automator,
Choose ‘File > Save As Plug-in...’ $" S,
Choose ‘Accelerando’ from the ‘Plug-in for:’ pop up menu in the save dialog.
Press 'Save'.

Your workflow is saved to:
~/Library/Application Support/Accelerando/Workflows/
If you use the default Search Location, this workflow will appear in the Search Results. If you use the default settings for Links, this workflow will be available as a
Link.
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Running a Workflow from Finder
To run a saved workflow by double clicking or opening it from Finder:
1) Select the saved Workflows from Finder.
2) Get Info ( cmnd+I )
3) Set the workflow to open with "Automator Launcher".
The saved Workflow should now execute when opened or double clicked, instead
of opening in Automator.
Also, you may save the workflow as an application by selecting File > Save As…
in Automator, and then specifying Application as the Format. Where applicable, the
application will accept files being dropped on it and may be processed by the
workflow.
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Automator Action Descriptions
by Category

Accelerando User’s Guide!

67

Func tionally similar Ac tions
Some actions which are very similar in use are documented in the Finder category.
For example, the action 'LP-Key Command' is documented by the Finder Action
'FDR-Key Command'. The functional di!erence between the two Actions is that 'LPKey Command' attempts to target Logic Pro, where 'FDR-Key Command' attempts to
target Finder.

General Use Actions
'Key Command' is a generic Action in the sense that it is intended for virtually any
application. The general use actions are found in the Accelerando Library.
The benefits of using the Application specific Actions such as 'LP-Key Command' is
that the configuration is simpler since it has been consolidated into 1 Action, they
also provide less chance of errors and testing. Application specific plugin based
workflows will usually run faster because it takes Automator some time to step
one Action to the next. In short, they o!er workflows which have fewer errors (
less time debugging a workflow ), and are faster to execute and configure.
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Ac c elerando Family
Comment Automator Ac tion

This action allows you to leave notes within your workflows or may be used as a
prompt or message during runtime.
Input: (Anything) This Action does not use Input objects.
Result: (Anything)
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Copy Tex t to Pasteboard

This action copies your text to the System's pasteboard.
Input: (Anything) This Action does not use Input objects.
Result: (Anything)
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Fast Iterate 3

Performs a sequence of 3 Key Commands one or multiple times.
Note: Use the Shift button instead of entering the Key using Shift.
Requires: The active application must be prepared to handle all Key Commands.
Input: (Anything) This Action does not use Input objects.
Options: Use the Delay parameters to insert a pause in seconds after each Key
Command is sent.
Result: (Anything)
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Fast Iterate 9

Performs a sequence of 9 Key Commands one or multiple times.
Note: Use the Shift button instead of entering the Key using Shift.
Requires: The active application must be prepared to handle all Key Commands.
Input: (Anything) This Action does not use Input objects.
Options: Use the Delay parameters to insert a pause in seconds after each Key
Command is sent.
Result: (Anything)
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Key Command

This action instructs the active application to perform the specified Key Command
with enabled Modifiers.
Note: Use the Shift button instead of entering the key using Shift.
Requires: The active application must be prepared to handle the Key Command.
Use another action to activate the application you want to target.
Input: (Anything) This Action does not use Input objects.
Options: Use the Delay parameter to insert a pause in Seconds after the Key
Command is sent.
Result: (Anything)
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Position Window

This Action allows you to set the position or size of a window.
Note: A window's index is the number of the window within an application, typically counted from front to back. A setting of 1 will usually be the frontmost window or panel.
Input: (Anything) This Action does not use Input objects.
Options: All measurements are in pixels. Position is relative to the upper-left corner of the screen. Size is absolute.
Result: (Anything)
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Postflight Error Handler

Recommended cleanup after a script is run.
Input: (Anything) This Action does not use Input objects.
Result: (Anything)
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Selec t Menu Item

Selects a menu item from an Application's Main Menu.
Warning: Retry on Error is not presently implemented.
Note: To choose a menu or submenu, set the destination as usual and check "Object is Menu".
Input: (Anything) This Action does not use Input objects.
Options: Reference types allow you to choose or specify items by Name or Index.
References by Index require integer values, Index based navigation may be required for certain menus, or when you want to select an item which changes it's
name - like "Undo (last action)".
Result: (Anything)
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Applic ation Spec ific Ac tions
Application specific Actions are prefixed by the application they are to be used
with.
Features and configuration remain the same throughout these actions, the di!erences are only what applications they target. Therefore, the descriptions have been
consolidated.
Many Actions have the same name but use what is called an Application Prefix.
Application Prefixes distinguish Application specific Actions by using a 2 or 3 character prefix followed by the Action name. The Prefix and Action are separated with
a hyphen. For example, FDR-Key Command is an Action which works with Finder,
we know by the FDR prefix. Therefore, all of Accelerando’s functionally similar Actions which work with Finder and are Prefixed with FDR-. See Appendix B for a
complete list of Application Prefixes.
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ALU- Ac tivate Apple Loops Utility
FDR- Ac tivate Finder
IB- Ac tivate Interfac e Builder
LP- Ac tivate Logic Pro
Peak- Ac tivate Peak
SM- Ac tivate Sample Manager
TM- Ac tivate Tex tMate
WB- Ac tivate WaveBurner
XC- Ac tivate Xc ode

Sets Application as the active application.
Input: (Anything) This Action does not use Input objects.
Options: Use the Delay parameter to insert a pause after activation. Delay time is
in Seconds.
Result: (Anything)
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ALU- Fast Iterate 3
FDR- Fast Iterate 3
IB- Fast Iterate 3
LP- Fast Iterate 3
Peak- Fast Iterate 3
SM- Fast Iterate 3
TM- Fast Iterate 3
WB- Fast Iterate 3
XC- Fast Iterate 3

Performs a sequence of 3 Key Commands one or multiple times.
Note: Use the Shift button instead of entering the Key using Shift.
Requires: Application must be prepared to handle all Key Commands.
Input: (Anything) This Action does not use Input objects.
Options: Use the Delay parameters to insert a pause in seconds after each Key
Command is sent.
Result: (Anything)
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ALU- Fast Iterate 9
FDR- Fast Iterate 9
IB- Fast Iterate 9
LP- Fast Iterate 9
Peak- Fast Iterate 9
SM- Fast Iterate 9
TM- Fast Iterate 9
WB- Fast Iterate 9
XC- Fast Iterate 9

Performs a sequence of 9 Key Commands one or multiple times.
Note: Use the Shift button instead of entering the Key using Shift.
Requires: Application must be prepared to handle all Key Commands.
Input: (Anything) This Action does not use Input objects.
Options: Use the Delay parameters to insert a pause in seconds after each Key
Command is sent.
Result: (Anything)
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ALU- Key Command
FDR- Key Command
IB- Key Command
LP- Key Command
Peak- Key Command
SM- Key Command
TM- Key Command
WB- Key Command
XC- Key Command

This action instructs Application to perform the specified Key Command with enabled Modifiers.
Note: Use the Shift button instead of entering the key using Shift.
Requires: Application must be prepared to handle the Key Command.
Input: (Anything) This Action does not use Input objects.
Options: Use the Delay parameter to insert a pause in Seconds after the Key
Command is sent.
Result: (Anything)
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Finder Family
Reveal Finder Loc ation

This action will reveal a location in Finder. An example would be to reveal a frequently accessed folder at a specific point in your workflow.
Note: This action does not act on the previous action's output.
Input: (Anything) This Action does not use Input objects.
Result: (Anything)
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Logic Pro Family
LP- Rec all Sc reenset

Recalls the specified Screenset in Logic.
Requires: Logic Pro must be prepared to Recall the Screenset.
Input: (Anything) This Action does not use Input objects.
Options: Screenset = The screenset to recall. Any number 1 to 99 which does not
end in zero. Delay = The amount of time in Seconds after Logic Pro is Activated.
Use this to control the amount of time before the next action.
Result: (Anything)
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LP- Set Ex ternal Sample Editor

Sets Logic Pro's default External Sample Editor.
Note: This process is not reversible.
Input: (Anything) This Action does not use Input objects.
Result: (Anything)
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Appendices
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Appendix A: Spec ial values for Key Command
related Ac tions
Accelerando supports several keys which can be di"cult to enter directly. All values for these special keys begin with capital letters since lowercase letters should
typically be used. These keys may be used with Key Command and Fast Iterate
Actions. The labeling convention is based on the key’s label in title case, where
applicable. The Command, Control, Option and Shift Modifiers may be used as
usual.
Example: In the picture below, ‘Down’ used in Key 1 will perform the down arrow
key. ‘Enter’ used in Key 9 will perform the enter key.

The following table lists the accepted special keys.
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^+-'.+;)Q+=

m%6:+)$")+#$+.

!6+%.

!6+%.

F%&?-6%-/

F%&?-6%-/

^+6>)".)^+6+$+)[M".0%.;\

^+6

^+6+$+)[F%&?\

^+6+$+

^"0#)J.."0

^"0#

*#;

*#;

*#$+.

*#$+.

MO

MO

MS

MS

MT

MT

MP

MP

MV

MV

M]

M]

Mf

Mf

Mg

Mg

Mh

Mh

MO`

MO`

MOO

MOO

MOS

MOS

MOT

MOT

j+6<

j+6<

j"2+

j"2+
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XOY)<"-'$'"#+;)%7"H+)6+$$+.+;)?+=-

Q+=O

XSY)<"-'$'"#+;)%7"H+)6+$$+.+;)?+=-

Q+=S

XTY)<"-'$'"#+;)%7"H+)6+$$+.+;)?+=-

Q+=T

XPY)<"-'$'"#+;)%7"H+)6+$$+.+;)?+=-

Q+=P

XVY)<"-'$'"#+;)%7"H+)6+$$+.+;)?+=-

Q+=V

X]Y)<"-'$'"#+;)%7"H+)6+$$+.+;)?+=-

Q+=]

XfY)<"-'$'"#+;)%7"H+)6+$$+.+;)?+=-

Q+=f

XgY)<"-'$'"#+;)%7"H+)6+$$+.+;)?+=-

Q+=g

XhY)<"-'$'"#+;)%7"H+)6+$$+.+;)?+=-

Q+=h

X`Y)<"-'$'"#+;)%7"H+)6+$$+.+;)?+=-

Q+=`

B+5$)J.."0

B+5$

X`Y)"#)$/+)#:2+.'&)?+=<%;

W:2`

XOY)"#)$/+)#:2+.'&)?+=<%;

W:2O

XSY)"#)$/+)#:2+.'&)?+=<%;

W:2S

XTY)"#)$/+)#:2+.'&)?+=<%;

W:2T

XPY)"#)$/+)#:2+.'&)?+=<%;

W:2P

XVY)"#)$/+)#:2+.'&)?+=<%;

W:2V

X]Y)"#)$/+)#:2+.'&)?+=<%;

W:2]

XfY)"#)$/+)#:2+.'&)?+=<%;

W:2f

XgY)"#)$/+)#:2+.'&)?+=<%;

W:2g

XhY)"#)$/+)#:2+.'&)?+=<%;

W:2h

XaY)"#)$/+)#:2+.'&)?+=<%;

W:2J;;

XeY)"#)$/+)#:2+.'&)?+=<%;

W:2^'H';+

XnY)"#)$/+)#:2+.'&)?+=<%;

W:2U:6$'<6=
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X1Y)"#)$/+)#:2+.'&)?+=<%;

W:2I+.'";

X3Y)"#)$/+)#:2+.'&)?+=<%;

W:2A:7$.%&$

I%(+)^"0#

I%(+^"0#

I%(+)N<

I%(+N<

,+$:.#

,+$:.#

,'(/$)J.."0

,'(/$

E%7

E%7

N<)J.."0

N<
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Appendix B: Applic ation Prefix es
Application specific Actions are prefixed by the application they are to be used
with.

I.+5'G

J<<6'&%$'"#

J

J&&+6+.%#;"

JBN

J<<6+)B""<-)N$'6'$=

M^,

M'#;+.

LF

L#$+.5%&+)F:'6;+.

BI

B"('&)I."

I+%?

I+%?)I.")V1S

AU

A%2<6+)U%#%(+.

AI

A":#;$.%&?)I."

EU

E+G$U%$+

DF

D%H+F:.#+.

i!

i&";+

Accelerando User’s Guide!

90

